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✓ Gain insight into the computational 
resources required to solve an Ansys 
Mechanical simulation

✓ Leverages AI/ML to analyze millions of APIP 
data points from previously solved models

✓ Provides estimated values for total 
computational solve time and memory 
usage based on model size and cores used
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Enabling More Efficient and Accurate FEA Simulations

Leveraging AI/ML to Predict Resources 
Required for Mechanical Simulations

Improving Accuracy and Efficiency 
through Geometry-based Enhancements

✓ Improved simulation accuracy on complex 
models and parts utilizing geometry 
preserving adaptivity (GPAD) that 
automatically refines a mesh based on the 
initial geometry

✓ Eliminates the need for an over-refined 
mesh or advanced user knowledge

✓ Modify a CAD model, without losing the 
associativity of the model’s features after 
setup

✓ Using geometry-based re-associativity with 
the Scoping Wizard detects and 
reestablishes scoping

Easing the pain of geometry updates 
with Geometry Based Associativity



✓ Optimize frame and shell structures using a 
new topography optimization method

✓ Improves the structural durability of the 
component while minimizing mass

✓ Eliminates unwanted scenarios like 
increased noise and vibration
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Enabling More Efficient and Accurate FEA Simulations

Optimize Frame and Shell Structures 
through Topography Optimization

Generate a High-quality Mesh

✓ Improvements will help to generate a 
higher-quality mesh that meets your 
criteria the first time

✓ Tetrahedral meshes for drop test 
simulations and feature suppression

✓ Swept hexahedral meshes and meshes for 
welds and shells

✓ Overall general usability improvements

Efficiently Setup Contacts for Complex 
Models

✓ An improved and simplified setup method 
now enables contact creation for complex 
models in less time

✓ Removes the need for duplicate contact 
setup and book-keeping of top/bottom 
faces of sheet bodies

✓ Includes models like contact between 
adhesives and metal sheet components 
common in Body in White (BIW) durability 
models.



Mechanical



Automated Rescoping 
Using Geometry Based 
Associativity (GBA)
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GBA:  Scoping Wizard 
• The Scoping Wizard is a tool that provides a list of the objects with missing scoping due to 

geometry updates. It provides the count of missing items, and the visual view of the previous 
scoping.

• Scoping Wizard for Model object in Tree:

• Shows a list of all objects with 
unresolved scoping.

• Context menu options in the 
wizard allow the user reassociate 
the matched scoping, remove 
the object from the Wizard view, 
or zoom in the graphics for a 
closer look.

• State icons show in the first 
column
‐ Green shows items that have an exact 

one to one match for each reference.

‐ Red shows items that has no matches

‐ Yellow shows items that have 
multiple-matches.  
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GBA:  Scoping Wizard
• Scoping Wizard for non-Model 

object

• A second list will show, 
enabling the to user to 
visualize each reference that is 
missing.

• When the user selects the 
“Reassociate” option, only 
those items with a green icon 
(one-to-one matches) will be 
relinked.  

• The old geometry tessellation 
will show with any potential 
matches.

• Context menu options in the 
2nd list allow the user to 
reassociate, remove or zoom 
to a specific geometric entity.
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GBA:  Scoping Wizard - Preferences
• Preferences exist in the Options panel to 

turn Geometry Based Associativity off/on 
and to make it automatic or user 
controlled.  

• By default, GBA will be on, with automatic 
scoping turned off.

• Options also exist in the Scoping Wizard to 
turn graphical options on and off.
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GBA Graphics

• Chose “Yes” to Geometry preference option Use Geometry Based 
Associativity when updating the geometry in Mechanical.
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GBA Graphics

• Bounding Box  - Displays bounding box of the scoped reference before geometry 
update. It displays for selected item(s) in the worksheet.

• Geometry Tessellation - Displays full tessellation of the scoped reference before 
geometry update. It displays for selected item(s) in the worksheet.

• Multiple Matches - Displays only references that are of type Multiple Matches.

• Matched - Displays only references that are of type Full Match.

• No Matches - Displays only references that are of type No Matches.
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GBA Graphics

• At model level old geometry tessellations are displayed in green, yellow or red based on the 
matched type Full Match, Multiple Matches or No Matches, respectively.



Geometry Preserving 
Adaptivity(GPAD)



Geometry Integrity in Simulations

• Complicated geometries are difficult to mesh and 
may be impossible for user to determine proper 
mesh sizes a priori due to complicated geometries.

• Resulting meshes may not capture proper stress 
and deformation fields during analysis.

• GPAD capability leverages the Ansys meshing 
capability and the robust nonlinear adaptivity 
feature in Ansys Mechanical.

• Automatically refines the mesh to the initial 
geometry (instead of initial mesh boundaries) 
adaptively to improve solution accuracy.

Nonlinear Adaptivity: Circular hole approximated by 
initial coarse mesh. Remeshing occurs within the same 
initial mesh boundaries.
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Geometry Preserving Adaptivity

• Supports:
‐ Linear analysis (NLGEOM, OFF)
‐ Lower and higher-order tetrahedral elements
‐ Elastic and elastoplastic materials
‐ Contact capabilities 
‐ Incorporates defeaturing effects during 

remeshing
‐ In-built sizing controls for remeshing:

• Element size control 
• Equivalent stress or equivalent strain criteria

‐ Mesh exploration feature for complicated 
models

‐ Improved solver messages for a better 
understanding of the remeshing process

• Typical Use Case:
‐ A complex model / part such as an engine block 

or manifold with several geometric features, 
where a user does not know where to refine the 
initial mesh

https://commons.wikimedia.org/wiki/File:CarterBMW1.JPG



GPAD – Mesh Exploration or Aggressive Remeshing

Initial Geometry & Mesh

Final Mesh with Aggressive 
Remeshing



GPAD – Accurate Geometry Recovery Through Mesh adaptivity



GPAD - Element Size based remeshing control

WITHOUT ELEMENT SIZE LIMIT (4 remeshings)

WITH ELEMENT SIZE LIMIT (Only 2 remeshings)

COMMAND:
NLMESH,ELSZ,10



GPAD – Equivalent Stress and Strain based remeshing control

Remeshing Limited by Equivalent Stress or Strain 
levels (NLMESH,NSTR/NSTN)



GPAD and NLAD - Improved Solver Messages for Mesh Rejection

Inadequacy of mesh quality is determined by:
• Skewness
• Jacobian ratio
• Maximum element angle
• Or combination thereof



GPAD Meshing – Incorporating Defeaturing during Remeshing

Part geometry and initial meshing 
The embossment “A” is defeatured 
during meshing

Embossment “A” ignored 



Messages Window 
Enhancements



• UI options to filter messages based on their severity.

• This can also be controlled from File->Options->Mechanical->Messages

23

Message Filtering



• ‘Merge Messages’ option will combine similar messages with the same severity into a 
single message. This is On by default.

• This can also be controlled from File->Options->Mechanical->Messages
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Message Filtering



• UI option to control if messages should ‘pop-up’ when a message is issued. When 
checked, messages will pop-up when issued by Mechanical. When unchecked, these 
will be hidden.

• This can be also controlled from File->Options->Mechanical->Messages
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Message Pop-up



Copy and Paste of Objects 
Using the Clipboard
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Copy/Paste Between Sessions Using Clipboard

• In 2022R2, Copy-to-Clipboard and Paste-from-Clipboard were only supported on 
Joints, Contact Regions, Coordinate Systems, and Named Selections. 

• For 2023R1, Copy-to-Clipboard and Paste-from-Clipboard has been made available 
for all copiable tree objects in Mechanical.



Command Snippet Output 
Search Prefix Supports 
Variables Inside Percentage (%) 
Symbols 
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Command Snippet Output Search Prefix – Variables Inside 
Percentage (%) Symbols
• Command Snippet’s Output Search Prefix recognizes parameters with variables 

inside percentage (%) symbols. 

• When creating the output parameters under Results category, the (%) symbols and 
the variable inside them are replaced by the value the variable has been set to using 
equal (=) symbol or *SET command, or if the variable is the iterator of a do loop, a 
range of parameters are created according to the limits of the do loop.



Close Mechanical During 
Launch If No License
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Close Mechanical During Launch if No License

• A new preference is available in WorkBench, Tools-
>Options->Mechanical, where user can stop from 
launching Mechanical when the checkout of licensing 
has failed

• Enabling this preference will display an error message 
whenever Mechanical is unable to checkout a License



Connection Statistics
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Connection Statistics

• Convenient access to overall connection 
counts without navigating to the Model 
Summary



Post Processing
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Separated scoping by 
entities in tabular data and 
graph

Utility Enhancements
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Before the enhancement

All bodies

Minimum, maximum and 
average values within ALL 
the bodies are reported in 
the Tabular Data and Graph
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With the enhancement

• When Separate Data By Entity is set to Yes
• Both Tabular Data and Graph now display 

the values for each entity in the scope with 
different color

Body ID



Multiple Crack Fronts
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Fracture Tool Results for Multiple Crack Fronts

• Fracture tool result (e.g., JINT) can be evaluated for all cracks, all or one of the 
crack fronts of a specific crack selection

Ring crack

Elliptical crack

Display fronts of all cracks

Display fronts of the selected crack
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Tabular Data and Graph

• For All Cracks selection in the fracture tool, tabular data and graph show results as 
specified in the Details

• For multiple crack fronts, the crack Front Number is indicated in the tabular data

First front

Second front

First front

Second front



Distance Probe
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Contact Distance Probe graphics

• Draw red line connecting the two bodies participating in a contact distance probe, 
during the animation. 

• This will appear as a rubber band stretching between the two bodies during 
animation.

• In chart and tabular data, the distance is used, but for the Graphics effect we need 
also the end positions of contacts at any time



Graphics Annotations for 
new Crack objects
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Introduction

• Previously, semi-elliptical and surface arbitrary cracks pre-existed. Now, with the 
work Somasekhar Kota did, we have new types of crack objects – namely elliptical, 
ring and embedded arbitrary cracks.

• We used to draw a half-torus in case of semi-elliptical cracks with two spider nets 
drawn at the ends of the half-torus tube. Now, in case of elliptical cracks, we draw 
the complete torus with just a single spider net, which indicates and corresponds to 
the element size set in the details and matches with the mouse cursor net.

• For surface arbitrary cracks, the origin of the coordinate system would be on the 
surface of the body and the buffer zone box would be only drawn in the positive X-
axis (towards inside of body). But now, with embedded arbitrary cracks, the 
coordinate system lies inside the attached body and as a result, we extend the buffer 
zone box in the negative X-axis with the same amount as in the positive X-axis.
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Elliptical Cracks (Tetrahedrons)

• Complete torus is now drawn as 
opposed to a half-torus in semi-
elliptical cracks (pre-existing)

• Two Mesh Methods:
‐ Tetrahedrons
‐ Hex Dominant

• Ellipse dimensions controlled by 
Major and Minor Radius in details

• Number of vertical red ticks 
controlled by Growth Rate in details

• Number of circles controlled by 
Mesh Contours in details

• Radius of torus tube controlled by 
Largest Contour Radius in details
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Arbitrary Through Crack (Embedded)

• The buffer zone box is 
extended in the negative 
X-axis by the same 
amount as in the 
positive direction

• If the crack edge on the 
negative X-axis direction 
intersects the attached 
body, it’s considered an 
embedded arbitrary 
crack. Otherwise, it’s a 
surface arbitrary crack



Graphics Export 
Enhancements
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Appending the Graph to Image Exports

• The Image to File feature and the related Graphics.ExportImage scripting API now offer 
a new option which allows an image of the exported viewport’s graph to be appended 
to the exported image of the viewport
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Composite Image Export (Windows Only)

• It is now possible to export a 
composite image of all viewports
‐ A thin black border can optionally be 

placed between or around viewport 
images to help visually separate each 
viewport image

‐ Note: Linux does not support multiple 
viewports, so this feature is only available 
on Windows

• This feature is accessible in the GUI 
via Insert > Image > Composite Image 
to File… and in the scripting APIs via 
the Graphics object

• This feature can also make use of the 
new “Append Graph to Image 
Exports” feature
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No-GUI Animation Export

• The Mechanical scripting API ExportAnimation (available on most result objects) can 
now be used in windowless batch scripting scenarios on Windows and Linux

• This API thus should be able to be used in all contexts where the 
Graphics.ExportImage API is available



51

Animation Export Example

• One example of how to use this feature would be via the Workbench scripting 
console

• Open the console and run:
‐ Simulation.RunScript(FilePath=“<path_to_mechanical_script.py>”, IsMeshing=False, 

ModelName=“<model_name>”)
• The FilePath parameter should be a string representing the path to a Mechanical scripting file (Python file utilizing 

Mechanical APIs, such as <result_object>.ExportAnimation(…))

• ModelName comes from the model cell in the Workbench schematic that you want to run this script for

▪ Right-click the cell and click properties to open the cell’s properties.  The “General > Component ID” property should contain the name 
to use



Display Graph in the 
Graphics window
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Display Graph in the current viewport window

• This feature allows displaying of graph in the graphics window. You can select 
the Display Graph option on the Graphics Toolbar or use the keyboard key G or the 
context (right-click) menu option to turn on the display. This display supports 
multiple viewports and remains active until you select one of the options to remove 
the graph.
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Embedded Charts in Graphics Window

• Enhanced results viewing with charts

• Multi-viewport animations – beta at 2023 R1



Expanded Support in 
Accelerated Animation and
Multi-viewport Animation
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Motivation for Accelerated Animation

• Accelerated Animation, despite the name, is not just about accelerating animation 
display. It also makes use of newer OpenGL technology to improve the fidelity of 
rendering, move away from (long) deprecated OpenGL calls, increase control over 
the rendering stack, and more. It also makes use of other techniques including 
asynchronous processing to improve the user experience.

• In many cases this does directly improve performance (both runtime and memory), 
sometimes drastically. In other cases this simply improves rendering and 
prepares for other enhancements and on the fly changes (such as on the fly legend 
updates without any graphics regeneration).

• Ultimately this feature is the first fruits of a larger initiative to revamp Mechanical 
result display for a variety of goals, of which performance is only one.
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Additional Support in Accelerated Animation

• Vector Results

• Tensor Results

• Results scoped to Faces, Edges, Vertex, Nodes, Elements or Element Faces

• Changing Meshes (NLAD, SMART Fracture, etc.)

• Harmonic Results

• Isoline display



FE Selections used 
with Section Plane Enhanc
ements
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Appending the Graph to Image Exports

• Selecting mesh (FE) entities located on geometry that are hard to access directly, 
without using section planes

• Before, if section planes were used to visualize some entities located for ex, inside of 
the model, picking was not taking the section planes into account, creating confusion 
since apparently “invisible” entities were selected and not allowing to pick what was 
seen!

• Now, with this feature, the behavior it is more like “what you see is what you pick” 
WYSIWYP
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How to activate...
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Example (an enclosure that is not obvious without using section 
planes)
• Previously if section planes are present, faces on most exterior of the model are 

picked (slightly rotated here from the shoot direction to help understanding) - this is 
non intuitive for the user and not helpful

• Now, entities inside can be picked because the section plane information is 
considered
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Notes

• ALL ACTIVE section planes are considered allowing customization of small areas hard 
to access otherwise (cut both to the left and right for ex.), but here the user must 
keep in mind that the true behavior is close with geometry (subtractive) section 
planes than with the mesh/results section planes behavior.

• Picking is not working on the capping - this is not the object of this work - capping is 
not normally part of the mesh.

• Hidden bodies will behave appropriately as before and while they could have been 
used before also to customize areas to pick, for single intricate bodies this was not 
an option as in the example above.

• Section planes have exterior and volume modes, this feature should work on both 
selection types and with any of single, box or lasso modes.

• Picking can be used also directly on (meshes of) results



Composites
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Short Fiber Composites
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Short Fiber Composites in Workbench LS-DYNA

Same workflow for implicit (MAPDL) and explicit 
analyses (LS-DYNA):

• Import results from the most popular injection 
molding simulation tools using the Injection 
Molding Data system.

• Calibrate the anisotropic, orientation-
dependent elasto-plastic material in Material 
Designer. 

• Set up the model and post-process the results 
in Mechanical.

Moldflow 
Moldex3D

SIGMASOFT
CADMOULD



ACP and Composite 
Workflows
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User Interface in ACP

• The user interface has been improved in these areas:

‐ Reordering the composite lay-up is made easier by introducing 
keyboard shortcuts and mouse actions.
Modeling Plies, Modeling Groups, Scripts and Extrusion Guides 
can now be moved with Drag-and-Drop or Cut-and-Paste. 

‐ Support for the Context Menu key in the Tree View has been 
added.

‐ Folders in the Tree View can be unfolded and folded with a 
double-click.

Context menu of a modeling ply with 
new actions and shortcuts

Drag & Drop: selected plies (in blue) are 
placed after the target ply (in orange)
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Sampling Point - Laminate Properties of Variable Materials

• Laminate properties such as the stacking sequence and equivalent stiffnesses can be 
analyzed by the Sampling Point in ACP and Mechanical. The Sampling Point now 
supports variable materials as shown below for a ply with draping and shear-
dependent properties.

Draping of a dome

Laminate properties without shear Laminate properties at 30° shear
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HDF5 Composite CAE Interface

• The export interface of the HDF5 Composite CAE format has been improved in the 
area of layer representation. The user has now the choice between no offset, 
bottom, middle or top. This allows new usages, for example collision detection or 
solid modeling.

• The HDF5 Composite CAE interface now supports user defined scalar fields. The 
scalar fields can be imported into ACP where they are available as Lookup Tables and 
Field Definitions. This allows the user to define variable material properties based on 
the imported scalar fields.

ANIFORM 
(virtual forming)

HDF5 
Composite CAE

ACP
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Other Enhancements

• The performance of the composite tools in Mechanical 
has been improved again, especially if multiple failure 
plots and sampling points are defined.

• Labels highlighting the minimum and maximum value of 
a plot can now be shown. They are toggled from this 
button         in the toolbar.

• Some issues in the visualization have been resolved.

• Support of file paths with Unicode characters.

• The file size of the ACP DB (.acph5) has been optimized.



Material Designer
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Triply Periodic Minimal Surface RVEs

• New pre-defined RVEs in Material Designer:

• Easily simulate these commonly used types of infill

Schwarz PGyroid



Structural Optimization

73
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Overview of the different methods

new method

For 23.r1, Additive Suite license 
is not requested anymore 

to use AM constraints and 
Lattice Optimization



New Optimization Methods

Topography & Mix-of-Methods 

75
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Structural Optimization

• New Analysis Settings options for X17: 
‐ Multi Optim Type Strategy: PG, On, Off

‐ Algorithm: PG, MFD, SCPIP

• Exclusion Extension option for Levet-Set & 
Mixable Density

• Mixable Density: Advanced Options:
‐ Initial Volume Fraction

‐ Penalty Factor

‐ Hyperbolic Projection
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Structural Optimization

• New Topography Optimization Type

• Thermal Condition support for Mixable Density

• Multi Optim Region support for Mixable Density
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Topography Optimization

Topography Optimization is similar to Shape Optimization in the sense that: 
‐ it is a free-morphing optimization,
‐ the setup is user-friendly: select the body to optimize and define the non-optimizable region,
‐ the degrees of freedom for optimization are the nodes location,

By contrast to shape optimization, Topography Optimization is dedicated for shell model.

The set-up is similar to Shape Optimization:

• Move Limit Per Iteration that enables you to define how far each node can move at each iteration (“dx” - element size- by default)

• Total Move Limit that enables you to define how far each node can move in total (5.dx by default). 

• Mesh Deformation Control: That enables you to define how much the mesh can be stretched. (0.5 by default)

Current capabilities

• about the Geometric Analysis: mass and volume

• Static Analisis: compliance and any static-UDC (User Defined Criterion) 

• Modal Analysis: any modal-UDC (single frequency, robust frequency, etc)

• Element type and order: triangles/quadrangles, linear/quadratic

• compatible with the capabality « mix-of-methods »
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learn by examples (1/2)

Mechanical setup 
& Mesh

Optimization setup Solution 

min

105%

Total Move Limit 2.5mm

compliance

volume






 


Static analysis:
Displacement-field

Disp-field of static analysis
20x stiffer 

Nodes motion

Modal Analysis, 
with remote mass

1,..

Maximize average frequency

1
max i

i n

f
n

=







1

Maximize 1st eigenfreq

max

105%

f

mass






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learn by examples (2/2)

Mechanical setup 
& Mesh

Optimization setup Solution 

1,..

Maximize average frequency

1
max

105%

Total Move Limit 5mm

i

i n

f
n

mass


=

  
  

 



 






7th eigenmode

Nodes motion

Modal analysis:
7-th eigenmode

Maximize reaction-force

Total Move Limit 0.5mm






static analysis 
displacement field

Static Analysis with 
thermal load only

Displacement-field

Nodes motion



Multiple Optimization Types

(i.e. Mix of optimization Methods)
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Multiple Optimization type Capability

Context
• there are multiple optim methods (topology, lattice, shape opt) but none fits for all needs
• each is dedicated for a specific context, specific needs and specific expectations
• Topology optimization: 

• aims to sketch a design from scratch;
• rather fits in early stage of conception;
• delivers the best design within a working domain;
• is an IBM approach, not accurate but highly permissive.

• Shape optimization: 
• improves an existing design by bringing local modifications;
• rather fits in late stage of conception;
• delivers the best modification to improve a given design;
• is a body-fitted approach, accurate but less permissive.

• For an orphan component, just chose the appropriate approach. But for a system with 
multiple components, one method is not always adequate. It is sometimes necessary to 
use specific optimization method on each component. 

Since 2023 R1, it is possible to  
• solve an optimization problem
• ... with multiple optimization regions
• ... having their own optim method (Topology, Shape opt. , Topography)
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learn by examples (1/2)

Mechanical setup 
& Mesh

Optimization setup Solution 

Static analysis:
Displacement-field

Steel

Aluminum

Two optim region 
-one by shape opt
-one by topology

Criterion of interest:
average disp of the 
loaded surface

( )

6

min
Optim problem

1.35

this problem has no solution if the hook is not optimizable

A

mass

DISP e m−




 level-set
+shape opt

mix-simp
+shape opt
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learn by examples (2/2)

Mechanical setup 
& Mesh

Optimization setup Solution 

7th eigenmode

Nodes motion

static analysis displacement field

Static Analysis with 
prescribed displacement

Displacement field

min

35%

compliance

vol







min

700

volume

compliance





 −

min

30%

+housing constraint

compliance

vol









shape opt result Topology result

2 optim regions: shape opt & topology

2 optim regions: 
Topography & Topology



New Features & 
Capabilities

new manufacturing constraint,

design constraint and more

85
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Topology Optimization – Housing constraint

The Housing is a manufacturing constraint 
that has been introduced in 2022 R2.

It enables you to create a watertight design 
that encloses a given set of faces. Topology 
optimization often generates designs that 
include holes and perforations. Using this 
manufacturing constraint, you can create a 
container to house a given liquid.

Housing constraint is available both with 
Level-set and Mixable-Density Topology 
Optimization. 

Static Analysis
Solution without

Housing Constraint
surfaces

to enclose

Solution with
Housing Constraint
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Shape Optimization
Design constraint

Design constraints are now available in Shape Optimization: 
- cyclic symetry,
- plane symetry
- and pattern repetition (beta)

Case #1: Static Analysis, 
1 loadcase

min

100%

-cyclic symetry

compliance

mass

x






+


Case #2: Static Analysis, 
6 loadsteps

Initial design 
= random beams

1,3

min

100%

-cyclic symetry

k

k

Compliance

mass

x


=






+





About the example:
- Wheel under static analysis
- the initial beams have been 

randomly designed
- how to improve to stiffness while 

keeping cyclic symmetry

Optimizable faces
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Learning by examples

Optimizable surface

Stress

min

105%

stress

mass







Stress

nodes-motion

min

105%

yz-plane symetry

stress

mass






+


Mechanical setup 
& Mesh

Optimization
setup

Solution 
(without symetry-constraint) (with Symetry)

Stress-reduction for a manifold

Stiffness increase 
for a thin solid Lbeam

nodes-motion

disp

disp

min

105%

compliance

mass







min

105%

z-plane symetry

compliance

mass

x






+

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Exclusion Region: Special Extension

The Exclusion Region properties enable you to 

specify a region to be excluded from optimization. 

Since 22r2, the thickness is editable in Mixable-Simp 

and Level-set Topology optimization. 

In 23r1, you can also choose the extension type: 

-Isotropic: expansion in every direction from the 

selected surfaces 

-Orthotropic: expansion along the surface normal. It 

is available when selecting a surface. For edge or 

node, it is Isotropic only.

Regions to exclude
(in red)

Mixable-Simp Level-set

is
o
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o

p
ic

O
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h
o
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o

p
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Improvement & Corrections
✓ Mixable-Density Topology Optimization

• Thermal-load in Static Analysis is supported in 23r1. The handling is fully
consistent between Level-set, Mixable-Simp, Shape opt. and Topography. 

• Correction in the computation of the derivative for static criteria in the 
presence of acceleration. 

• Three advanced parameters are available :
“initial volume fraction”,
“penalty factor” and “hyperbolic projection”

✓ Level-set Topology Optimization
• Many improvements have been introduced leading to a faster machinery. 

The computation per iteration is more than 2x faster.

✓ Multi Optim Type Strategy
• A special tuning has been introduced to handle the mix of optimization

methods. This new tuning is automatically activated for this context
• It can also be used for single optim method. 

It will affect the behavior of Level-Set 
and Shape Optimization.

• The strategy is more agressive 
and leads to better and faster results, 
but possibly less smooth. 

Thermal load with Mix-Simp

Multi Optim Strategy = off
nb iterations: 61
final compliance: 0.340J

Multi Optim Strategy = ON
nb iterations: 36
final compliance: 0.338j



Fracture Enhancements
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Fracture Enhancements for 2023 R1

• Mechanical supports embedded analytical
cracks of shape Elliptical and Ring inside a solid
body

• Using Arbitrary Crack, Mechanical supports
Through cracks, Embedded cracks and cracks
intersecting at multiple corners

• Fracture results can be evaluated either for
all crack fronts or a particular crack front
associated to crack object
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Analytical Crack : Elliptical Crack

• Mechanical can now define an embedded analytical crack of elliptical shape using the 
Coordinate system and the Major Radius and Minor Radius

Mesh generates one 
elliptical crack front
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Analytical Crack : Ring Crack

• Mechanical can now define an analytical crack of ring shape using the Coordinate 
system and the Outer Major Radius and Outer Minor Radius, Inner Major Radius and 
Inner Minor Radius

Mesh generates 
two crack fronts
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Arbitrary Crack - Elliptical and Ring shaped

• Mechanical supports Arbitrary crack where crack mesh can be generated on an 
elliptical or ring shape crack surface body and embedded crack related fracture 
parameters can be computed
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Arbitrary Crack - Through Crack

• A crack surface body which cuts through the solid body will generate two crack fronts

Mesh generates 
two crack fronts
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Arbitrary Crack – Intersecting at multiple corners

• A crack surface body which intersects the free surfaces of the solid body at 
corners creates multiple crack fronts

Mesh generates 
four crack fronts



98

Crack Front Number property on named selections 

• Crack front named selections are numbered in the same order as they are created, and 
this number is used while post processing, as Crack Front Number property of Fracture 
Tool to extract fracture results and probes on a specific crack front
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Unique solver ids for fracture parameters

• We create and send unique solver ids for each

crack front, we create like:

_CRACK66_FRONT1_SIFS,1

_CRACK66_FRONT1_JINT,2

_CRACK66_FRONT2 _SIFS,3

_CRACK66_FRONT2 _JINT,4

Which can be used to post

process fracture results

through command snippets
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Fracture results for all crack fronts
All Crack Fronts will be the default option for Crack Front Number. This option plots the 
results of all crack fronts and displays cumulative results
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Results on specific crack front using Crack Front Number
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Results - All Cracks selection mode on Fracture Tool
• When All Cracks selection mode is selected on the Fracture Tool, you can specify the Crack Front 

Number below Crack Selection to plot the graph and table of fracture  results on a specific crack front 
of the selected crack
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SMART Crack Growth support for new crack shapes

• SMART Crack Growth can be defined for these new crack types to study the crack 
growth propagation and related fracture results and probes
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Commands (APDL) - For specific crack front

The Commands (APDL) object provides a Crack Front Selection property that enables 
you to execute commands specific to a crack front. Property options include All (default),
First, Last, and By Number. When you select the By Number option, an additional 
property displays: Crack Front Number.



Coupled Field Features
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Electric Conduction in Coupled Field Transient

• Electric Conduction is now supported in 
Coupled Field Transient

• Coupling of Thermal and Electric Conduction 
can be performed

• Coupling of Structural and Thermoelectric 
Conduction can be performed

• Applications include
‐ Joule heating in various application

‐ Thermocouple design

‐ Thermoelectric Micro-actuators

‐ Many others
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Electrostatic Force Coupling in Coupled Field Static

• Electrostatic Structural analysis with Electrostatic 
Force coupling is now supported in Coupled Field 
Static

• This coupling is also supported with
‐ Electrostatic Structural coupling with Piezoelectric

‐ Electrostatic Structural coupling with Acoustics 

• Applications include
‐ Electroactive polymer actuators

‐ Electrostatic micro-electromechanical-mechanical 
devices (MEMS) such as electromechanical switches, 
sensors and actuators

‐ Comb drives, accelerometers, torsional

‐ Micromirrors and Gyroscopes
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Electrostatic Force Coupling in Prestressed Coupled Field 
Harmonic

• Prestressed Coupled Field Harmonic analysis can 
be performed with these couplings:
‐ Electrostatic Structural coupling

‐ Electrostatic Structural coupling with Piezoelectric

‐ Electrostatic Structural coupling with Acoustics

• These couplings need to be defined in the 
upstream Coupled Field Static 
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4. General Miscellaneous Enhancements

• Acoustics PML is supported in Coupled Field Transient

• Charge Residuals supported on Solution information object. Charge residuals can be 
plotted and viewed for nonlinear solutions that either do not converge or that where 
aborted during the solution.

• System Coupling is now supported with Coupled Field when either Structural or Thermal 
physics are present or when both physics are present.

• For Structural-Thermal physics, the lower order mesh now uses the SOLID225 element 
formulation instead of SOLID226 (a high-order element) with the mid-side nodes 
dropped.



Contact and Connection 
Enhancements
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Contact Enhancements

• Small Sliding property is now supported when the Formulation 
property is set to MPC.

• Property options include:

• The small-sliding logic improves solution robustness. It can easily 
solve complex contact models having a bad quality geometry or 
mesh and non-smooth contact interfaces.

• Small Sliding is turned On by the Program Controlled setting for a 
No-Separation contact with Large Deflection turned off and for a 
Bonded contact. 
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Default Pinball Radius Factor for Shells

• When we define a contact, the APDL calculates a 
default pinball radius

• Circle for 2D or a sphere for 3D of 
radius 2*depth (rigid-flex contact) or 1*depth (flex-
flex contact) of the underlying element.

• In Mechanical, the default pinball radius factor when 
using Program Controlled option is always set to 
‐ 0.0 for most contacts -> solver will decide the factor.

‐ 1.0 for shells (spurious contact and slow contact searching). 
Too Large!!

‐ Solver recommends 1.75 to 0.5 (rigid – flex), 0.5 to 0.25 (flex-
flex) for bonded and no separation contacts
• Solution: Issue 0.0 and let solver decide the pinball radius factor
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Default Pinball Radius Factor for Shells

• In 2023 R1 issue a factor of 0.0 for MPC Bonded and 
No Separation Contacts on shells

• Please use the beta feature to specify pinball radius 
factor manually for legacy databases if required

• Future work: Extend for other contact formulations

Input File
Output file 
(solve.out)
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Projected Contact for Gaskets

• Send the KEYOPT(4) = 3 when
‐ If Detection Method is set to Program Controlled AND

‐ The contact is scoped to a gasket 

• Advantages:
‐ This setting enforces a contact constraint on an overlapping 

region of the contact and target surfaces rather than on 
individual contact nodes

‐ Prevents displacement overshoot for gasket elements

• Disadvantage:
‐ Computationally more expensive
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Edge-Edge Detection

• For beams bodies, Beam-Beam Detection property 
was available. Rename it to Line-Line Detection.

• This property Line-Line Detection available when 
Edge Contact Type is set to Line Segments.

• The option defaults to External-Up to 4 segment 
which will set Keyop, cid, 14,1
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An example shown below where the edge contact with Line-Line 
detection option gives better results

External –up to 4 segment option gives better results
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Connection Enhancements

• Lagrange Multiplier for Remote Points and Joints: 
‐ Remote Point and Joint objects have a new property: 

‐ Formulation: This property enables you to specify the contact 
algorithm the application uses for a particular remote point 
computation. Options include-
• MPC (default): This option creates multipoint constraint equations internally during 

the Mechanical APDL solution to tie the bodies together.

• Lagrange Multiplier: This option enforces zero penetration when the contact is 
closed, making use of a Lagrange multiplier on the normal direction and a penalty 
method in the tangential direction. This formulation helps to overcome over-
constraint problems better than the MPC formulation.

‐ In previous releases, these remote point-based boundary conditions 
used the MPC formulation internally. Now, with the option to specify 
Lagrange Multiplier, user can better eliminate over-constraints.
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Connection Enhancements

• Relaxation Method for Remote Points and Joints: 
‐ When Formulation property is set to MPC, the Remote Point and Joint objects display a new 

property: 
• Relaxation Method- When MPC-based surfaced-based constraints or rigid bodies are subjected to over-constraints, this 

method (when set to Yes) relaxes the constraint between contact-generated internal constraint equations and other 
constraint equations.



Materials
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Finite strain plasticity material model

• Combines hyperelasticity and von Mises plasticity with 
isotropic hardening
TB,HYPER + TB,PLASTIC,,,,BISO|MISO or TB,NLISO

• Multiplicative split of mechanical deformation gradient 
into elastic and plastic parts: 𝑭𝑚 = 𝑭𝑒𝑭𝑝

• Allows for large elastic strains and large plastic strains

• Supports displacement based and mixed u-P element 
formulations

• Supports three-dimensional, plane strain, generalized 
plane strain, axisymmetric, axisymmetric with torsion and 
general axisymmetric conditions

SEQV

Necking of circular bar

EPPLEQV UX



Material-agnostic Generalized TMF Damage

- Fatigue failure is widespread in many engineering applications
• E.g. structures with simultaneous cyclic thermal and structural loading

- Need for material-agnostic regularized damage model
• Damage materials lead to strain softening behavior: use regularization

• Pervasiveness of fatigue failure in different industries: many different materials

• Gradient regularized damage greatly improved solution robustness

- TMF damage model can be applied to most native Ansys nonlinear 
materials

• Formulate based on incremental inelasticity

• Damage driven by inelasticity 

• Applicable to bilinear and multilinear isotropic/kinematic hardening, rate-dependent Chaboche
(viscoplasticity), Drucker-Prager materials

- TMF damage can be directly coupled with thermal and pore fluid 
diffusion

- Pore fluid diffusion is based on Darcy Law

121

- TMF damage model
- 3 fields coupled (structure, 

thermal and damage)
- 20 cycles of load

Damage evolution
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Mesh Independent INISTATE

• Ability to apply INISTATE on a cloud of points to be used later by 
the generated finite element mesh.

• User Field Variables and Elastic Stress or Elastic Strain 
supported and applied as functions of Location, Time, 
Temperature and Frequency

• Supported for Solid Elements PLANE182/183, 
SOLID185/186/285

• Can be applied as Node-Based or Element-Based or Free-Form 
to be used for any other purpose (ex :fracture)

• Multiple convex zones of data can be applied to portions of the 
model to reduce data size and improve performance when and 
where applicable
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AML Development Update

• Models to be covered for calibration in the order of 
priority
‐ Viscoelasticity with Prony series
‐ Frequency viscoelasticity with Prony series

• ML/AI assisted calibration for robustness and performance
‐ Parameter initiation for BB and TNM

• GRPC (by WB EDA Team)
‐ GRPC Server and additional C Sharp Layer to support HTML close 

to completion.
‐ Addition implementations in the GRPC Server for the future for 

other AML features
‐ GRPC Server extensions to support Python interface(by WB EDA 

Team) scheduled for the future

• HTML Based UI by Materials BU to support hyperelasticity
in progress
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Viscoelastic Materials Fitting

• Parameter fitting is now supported for Prony 
Series with Shift Functions
‐ TB,ELAS with TB,PRONY and TB,SHIFT(if needed)

• Experimental Data Supported
‐ Shear Modulus Vs Time 

‐ Bulk Modulus Vs Time 

‐ Shear Modulus ( Real + Imaginary Components) Vs 
Frequency

‐ Bulk Modulus ( Real + Imaginary Components) Vs 
Frequency

• Temperature dependency supported 0.00E+00

1.00E+05

2.00E+05
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2023R1 Contact & Nonlinear Solver Heuristics Enhancements

• Support contact for 2D axisymmetric elements with torsion ROTY

• DMP contact performance improvement: 
‐ Distribute underlying elements of target surface into different domains for node-surface contact 

CONYA175
‐ Concurrent contact trimming and pair splitting to avoid external element numbering overflow

• Contact options for shells – BIW workflows
‐ Double sided target surface
‐ Limited CEs for rigid constraint under small deflection

• Contact result, convergence history tracking in PyMAPDL

• Enhance NLHIST stop criteria: tracking result variables to terminate solution besides contact 
results

• Improve robustness for transient dynamics: initialized acceleration, backward-Euler 
integration scheme as default for 1st order equations.

• Improve accuracy for New-Raphson iterations: refine force/displacement convergence 
tolerances.



2D axisymmetric elements with torsion ROTY

Coupled field brake transient 
analysis

• Frictional contact was traditionally unsupported for 2D elements with torsion DOF 

• Frictional forces in radial, axial and circumferential directions are now supported

• Example below shows the frictional heat dissipation in a coupled thermal-structural model



Double Sided Target Surface

• Adhesives in BIW models may have to be bonded with both top/bottom shell 
surfaces – requires two separate definitions 

• Double-sided target surface option reduces setup to only one set of the target 
surface. 
‐ Reduces the total number of target elements

‐ Make setup easier for models in which orientations of underlying shell elements are arbitrary or not 
consistent.



Double Sided Target Surface

For arbitrary target 
surface normal, the 
single sided target 
definition either misses 
contact detections or 
builds CEs across over 
both sides of gasket 
elements 

Arbitrary target 
surface normal over 
shell elements 

The double-sided 
target definition 
builds CEs on correct 
sides

The double-sided 
target definition builds 
CEs on stick-out 
gasket nodes which 
improves robustness



Limited CEs for Rigid Constraint under Small Deflection

• Improvement in performance and reduction in 
memory usage for rigid surface constraint under 
small defection
‐ Only builds CEs on rigid nodes which connect to other 

elements or have applied boundary conditions

‐ No internal CEs are built for free rigid nodes (no 
connection to any other elements and no B.C.s)

‐ Geometry correction is made on free rigid body nodes 
during solution



Terminate analysis automatically based on tracked results

Analysis terminates automatically when the temperature of the probed node exceed 300 C in the transient run 



Behavior of Deleted 
Displacements (DDELE) in 
Restart and NLAD



DDELE in Restart and NLAD

• In version 2022 R2 and before:
‐ If a displacement boundary condition was deleted (using the DDELE command) during a regular 

analysis step,  then this deletion was not being honored in a restart analysis of the same step. 

‐ Analyses using nonlinear adaptivity (NLAD) framework also disallowed deleting previously imposed 
displacements.

• Solution:
‐ In version 2023 R1, the restart analysis will ensure that the previous deleted displacements are 

correctly observed.

‐ In the nonlinear adaptivity framework, previously imposed displacements can be deleted if these 
regions are not remeshed.



Simple Example of DDELE behavior with Restart

Behavior in 2022R2 Behavior in 2023R1
The loading is as follows:
• Apply displacements on top edge in load step 1
• DDELE the applied displacement in load step 2
• Restart from middle of load step 2



Simple Example of DDELE in NLAD

Behavior in 2022R2 Behavior in 2023R1

For NLAD, the region where DDELE is 
applied is not remeshed

Remeshing Region

The loading is as follows:
• Apply displacements on top edge in load step 1
• DDELE the applied displacement in load step 2
• Restart from middle of load step 2



Examples of DDELE in RESTART and NLAD

The loading is as follows:
• Apply displacement at the pilot node
• DDELE the applied displacement in load step 2
• Re-apply the displacement at the pilot node in load step 3
• Uses the restart framework

The loading is as follows:
• Interference resolution in load step 1
• Rotation in load step 2
• DDELE rotation in load step 3
• Uses the NLAD framework



Elements
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Coupled-Field Link Element (LINK228)

• Motivation
‐ Element embedding method already adopted in electronic reliability study

‐ Many PCB/Chip components can be simulated with line elements

‐ Need for coupled-field line elements to properly capture the physics

• Overview
‐ LINK228 : 3D 2-Node Coupled-Field Link

‐ Supported coupling types 
• Structural-Thermal , Thermal-Electric, Structural-Thermal-Electric coupling

‐ Supported analyses
• Static, Transient, Harmonic

‐ Max. DOFs : UX, UY, UZ, TEMP, VOLT
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LINK228SOLID225

Cold Junction 
Temperature

Case 1: Thermo-Electric coupling : Peltier Cooler

- Comparison between SOLID225 and LINK228
- Accurate results with smaller models
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Case 2: Structural - Thermo-Electric Coupling

- Electric field induced deformation
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T = 0
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Bending & Torsional Stiffness for Discrete Reinforcing Element

• Discrete reinforcing element REINF264 capable of uniaxial stiffness only before R23. 

• Bending and torsional stiffness required for embedded electronic (vias), civil (steel 
rebars), or biomedical (stents) components

SOLID186 model REINF264 model
w/ bending & torsional stiffness

PLES,U,USUM PLES,EPEL,X

Case 2: Bending of a braided catheter  

Case 1: Reinforcing vs. full solid models  
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Electrostatic-Structural Analysis Enhancements

• The electrostatic-structural analysis 
(KEYOPT(1)=1001) of elements PLANE222, 
PLANE223, SOLID225, SOLID226, and 
SOLID227 has
‐ A new keyoption (KEYOPT(4) = 4) to turn off the 

default electric force coupling

‐ New element output quantities available with 
the electric force coupling to make result post-
processing consistent with the piezoelectric 
coupling:
• electric current density (JS), 

• energies (Ue, Ud, Um, SENE, KENE, DAMP)

• Joule heat (JHEAT)

A linear perturbation harmonic 
analysis of the micromirror cell 
subject to a DC voltage bias
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MORPH Command Enhancement

• The MORPH command with the option that allows 
structural elements in the model (StrOpt = YES) 
now supports the morphing of the following 
meshes:
‐ Electrostatic

‐ Electric 

‐ Thermal

‐ Diffusion 

‐ Electromagnetic

‐ Coupled-field with no structural degrees of freedom 

Undeformed electrostatic mesh
Capacitance C0 = 62.4pF

Morphed electrostatic mesh following the 
displacement of a structural mesh to the left
Capacitance C1 = 64 pF

PLANE121

PLANE183



Radiosity Enhancements
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RADIOSITY ENHANCEMENTS

• View Factor smoothing enhancements
‐ Viewfactor smoothing (VFSM command) with options 2 & 4 produced different results if the surface 

facets are reordered

• New algorithm has been used to circumvent this issue.

• Energy balance for higher order elements
‐ In rare cases with complex geometries the energy balance may not be rigorously satisfied

‐ For higher order elements, the midside node TEMP is not transferred to the radiosity solver.

• RADOPT command will have a conservative option to address this issue which will 
reduce the energy imbalance to < 1%
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Radiosity Enhancements

• New algorithm to improve View 
Factor Smoothing (VFSM 
command)

• New energy conservative option 
on the RADOPT command to 
effectively reduce energy 
imbalance.

Nonconservative
Energy imbalance 7.6%

Conservative
Energy imbalance 0.0043%

Radiation between cylinders (dimpled surfaces)



Fracture
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SMART support for non-proportional loading

Non-proportional load support
• Support varying stress ratio across crack 

front
• Direct calculation of stress intensity factor 

range for fatigue crack growth prediction

• Crack propagation direction is calculated 
based on 
• Maximum stress intensity factor
• Minimum stress intensity factor
• Local maximum circumferential stress

Infante-Garcia, Diego, et al., 7th International Conf. on Crack Paths, 
CP2021, https://www.youtube.com/watch?v=HfPMCfUNLRA

Experiment

https://www.youtube.com/watch?v=HfPMCfUNLRA
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Crack-face-traction from initial stress

Crack size (mm)

K
1

 (
M

Pa
 m

m
0

.5
) 

Traction converted from initial 
stress is automatically mapped 
on the growing crack faces

Reference: Tada, H., Paris, P.C. and Irwin, G.R., 1973. The Stress Analysis of Cracks Handbook, 3rd ed, ASME Press, 2000, pg 396.

Approach:
• Initial stress is internally converted to crack 

surface traction for fracture calculation
• Support both static and fatigue crack 

growth
• Limited to linear application
Benefit:
• Computationally faster (No Newton 

Raphson)
• Requires initial stress data only in the 

immediate vicinity of crack faces

Remote tensile load (60 MPa)
+

Initial (residual) stress (-10 MPa)
(Mesh-independent data points)Residual stress field Equivalent traction load at crack faces

σij(x,y,z)



SMART with Cohesive Zone Modeling

Before insertion

Crack surface

Crack front

After insertion

Old crack surface
New crack
surface

New Crack frontCZM Elements

SMART crack growth with automatically inserting of interface element 
(INTER204) 
• Interface elements for initial crack surfaces
• Interface elements for new crack surfaces
Cohesive modeling with interface elements (CZM elements) can be
• Modeling the crack closure (penetration) only
• Modeling crack closure for compression and decohesion for tension

Pushing on B
Pulling on A
Fixing on C

Initial Crack

Crack Growth under asymmetric loadings



Von Mises equivalent stress
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Crack Arrest Modeling

• Four point bending beam with a side crack
‐ Line pressure loads are applied

• The model forms an asymmetric load pattern to crack where top 
part is subjected to compression and bottom part id under tension

‐ FCG is conducted
‐ Paris law with threshold is used
‐ CZM elements are automatically inserted at first 

substep and subsequent crack propagation substeps
‐ CZM elements are only to use for preventing crack 

surface penetration
‐ A small threshold value is used to prevent negative KI 

value used in the effective stress intensity factor range 
calculation

Crack front evolution with SIF KIFour point bending specimen 

A

B

A

B



MAPDL Solver
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Overview

• Resource Prediction

• Krylov Method for single physics harmonic – Primary target: NVH

• Advanced Iterative Solver for single physics full harmonic – Primary target: NVH

• Support for new libraries and AMD GPU
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Linear Static and 
Modal Analysis

Predict memory and solve time for 
both Direct and Iterative solvers

Unique AI/ML based approach for 
memory and solve time prediction

Click on Resource Prediction right 
after finishing model set up

Provide predicted value and range to 
understand how these are changing 
by increasing number of cores [32]
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What’s New?

• Shows Time Prediction in addition to 
Memory Prediction.

• Displays table data that includes a 
predicted value as well as a range of 
lower and upper values for time and 
memory.

• Provides Time and Memory charts with 
both predicted value and range for 
better understanding of computational 
resources.

• Supports model imported using 
External Model systems

Predicted Value 
and Range

Time and Memory chart

Time Prediction



Solve time predictions are now available in addition to expected memory needed
• Exposure of resource prediction is only via Mechanical GUI

• Improved accuracy for memory requirement predictions

• No longer using fixed classification bins but instead dynamic error ranges

Compute Resource Prediction



Resource Prediction Enhancements

Expected solve time predictions can 
help
• Get a sense of how long a simulation will 

take

• See which equation solver will likely run 
faster

• Gain insights about using more CPU cores 
(HPC)



Memory predictions are improved
• Get a sense of how much memory is required

• See which equation solver will use less 
memory

• Gain insights about using more CPU cores 
(HPC)

Compute Resource Prediction: Solver Memory Requirements



Harmonic Analysis Enhancements

Objective → speedup harmonic analyses
– FULL method → very computationally expensive (matrix factorization at every freq)​

– VT method → reduced method, limitations (must have smooth variation of load)

– MSUP method → reduced method, limitations (frequency dependent materials)​

New “reduced” method for solving harmonic analyses → KRYLOV

– Based on Krylov subspace → aims to improve performance over FULL method

– Available via new harmonic analysis option (HROPT,KRYLOV)

– Targeting single-field acoustic or structural harmonic analyses



KRYLOV Method

• Build subspace (Q) to reduce FEA model
– Step 1 → Form K, M, C, and f at middle of the specified frequency range (ω0)  → symbolic assembly → .full file

– Step 2 → Form Ǩ and Č   where Ǩ(ω0) = K - ω0
2M + iω0C  and Č(ω0) = C + 2iω0M

– Step 3 → Factor Ǩ-1 using direct solver

– Step 4 → Compute v1 = g1/|g1| where g1 = Ǩ-1f   and  f(ω0) = fr + ifi

– Step 5 → Compute v2 = ǧ2/|ǧ2| where ǧ2=ǧ2–(v1•ǧ2)v1       ǧ2 = g2/|g2| and g2 = –Ǩ-1Čg1

– Step 6 → Compute vn = ǧn/|ǧn| where ǧn=ǧn–(vn-1•ǧn)v1   ǧn = gn/|gn| and gn = –Ǩ-1(Čgn-1 + Mgn-2)   for n=3,dimQ

• Steps 5 & 6 use Modified Gram-Schmidt Orthonormalization
‐ Generates a set of complex-value basis vectors {v1,v2,…,vn} that are almost orthonormal

‐ Structure preserving dimension reduction → subspace Q = span(v1, v2,…,vn) is used to reduce the harmonic FEA



• Reduce system of equations and solve
– Step 1 → Form K, M, C, and f at the given frequency value (ωi)  → symbolic assembly → .full file

– Step 2 → Build A  where A(ωi) = K - ωi
2M + iωiC

– Step 3 → Use subspace Q to reduce A and f at each frequency value → [QTA(ωi)Q]y = {QTf(ωi)}

– Step 4 → Solve (dense matrix) reduced system via LAPACK to compute y at each frequency value

Project K, C, M, f on Q={v1,…,vn} to obtain reduced system at frequency ω

System of equations in Step 4 will be [dimQ] in rank → extremely fast

KRYLOV Method



•Expand system of equations back to FEA model
– Step 1 → Expand yi → xi = Qyi at each frequency value (ωi)

– Step 2 → Compute residual Ri where Ri = Fi – Ai xi where Ai = K - ωi
2M + iωiC

– Step 3 → Normalize residual Ri where Ri = |Ri| / |Fi|

KRYLOV Method



KRYLOV Method
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New commands

HROPT, Krylov, FrqVal
- Enable the Krylov method for the harmonic analysis
- [Optional] Specifies the frequency at which to generate the subspace (defaults to middle of 

supplied frequency range)

KRYOPTION, MaxDim,,, ResTol, CheckOrtho
- Optional parameters to control the following:

Maximum subspace dimension 
Tolerance used for the residual check
Activate the check on the orthogonality of the subspace vectors



KRYLOV Method

‐ Significantly faster than using the FULL method for harmonic analyses
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•1.8 MDOF; Sparse direct solver
• Harmonic analysis with 122 frequency 
points from 0 to 2000 Hz
• Linux cluster; each compute node 
contains 2 Intel Xeon Gold 6142 
processors (32 cores), 384GB RAM, SSD, 
CentOS 7.9, Mellanox Infiniband



Miscellaneous Enhancements

• Upgraded to v3.2.1 BLIS library for AMD processors
‐ Initial support for AVX-512 instructions for Genoa and future architectures by AMD

• Upgraded to CUDA 11.7 libraries for NVIDIA GPUs



Beta Features

• PCG iterative solver now supports harmonic analyses (BETA)
‐ Complex-value operations now supported in the PCG solver path

‐ Works well for single-field structural and acoustic models

‐ Fluid-structure interaction supported with some limitations

‐ Can significantly decrease the memory requirements over using the direct solver but still fully 
supports DMP and thus is significantly faster than using the ICCG or QMR solvers

• PCG iterative solver now supported with AMD GPUs (BETA)
‐ Sparse-matrix vector operation is now offloaded onto AMD GPUs

‐ Up to 10x faster operations for this offloaded solver kernel with same accuracy as CPU-only path



Linear Dynamics

166



167

Overview: Solver + UI/UX

• Multistage Cyclic Symmetry Analysis

• Substructuring/CMS

• Harmonic Balance Method (Beta)

• Elcalc support in spectrum analysis (Beta)

• Residual Vector Support with QRDAMP (Beta)

• Miscellaneous
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Multistage Cyclic Symmetry Analysis

• Stage Connections
‐ Many stages can be connected to any given stage, overcoming the prior limit of two stage 

connections per stage.  This allows models of greater complexity to be easily assembled. This also 
works with multiharmonic stages having multiple stage clones.

Multistage 5-Stage Model
Stage 2 With 3 Connections

Cross-Section of Expanded Displacements
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Support Mechanical 
more complex models
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Multistage Cyclic Symmetry Analysis

• Tabular Loads
‐ Node and Element based tabular loads 

applied to harmonic index 0 base sectors in a 
static analysis are automatically copied to 
the harmonic index 0 duplicate sectors and 
stage clones.

WB Mechanical Imported 
Load Tabular Data

/com,*********** Create Load Variation Table for Imported Load "Imported Body 
Temperature" ***********
*DIM, _lv_254__0, TABLE, 2, 54395, 1, TIME, NODE, ,
*PREAD, _lv_254__0, 163188

0.000000000000e+00  0.000000000000e+00 1.000000000000e+00  1.000000000000e+00
2.200000000000e+01  9.978023529053e+01  2.000000000000e+00  2.200000000000e+01
9.813773345947e+01  3.000000000000e+00  2.200000000000e+01  9.943675994873e+01
4.000000000000e+00  2.200000000000e+01  9.919849395752e+01  5.000000000000e+00

…

Support Mechanical 
Imported Loads
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Multistage Cyclic Symmetry Analysis

• Multistage Multiharmonic Harmonic 
Selection Tool (Beta)
‐ A python based tool offers guidance as to 

which harmonics for each stage may 
contribute to the overall multistage solution.

User Input for HI Selection

Output for HI Selection

Help customer pick the 
relevant harmonics
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Multistage Exposure in Mechanical

• Allow multistage for thermal analysis (HI=0)

• Stage can be connected to more than one upstream & 
one downstream stage

• Allow multiple harmonic indices for Static Structural analysis

• Allow Imported loads in Thermal & Static Structural (beta)

All Connect
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Improved performance for Substructuring Analyses

To improve performance, in R23.1 the default NUMSUBLV has been changed from 1000 to 31 in 
MAPDL and in Mechanical, and the workaround is no more needed.

In R18.0 the default for the maximum number of load vectors that can be generated and stored in 
Sename.sub file, NUMSUBLV, has been increased from 31 to 1000.

After developments done in R19.2, in the .esav file of a use pass, a record size associated to any 
superelement has been increased, which could slow down performance when a large number of
time points are calculated during the use pass. A workaround was provided into the documentation 
to overcome this issue.

Improve default settings for 
better performances
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• In Substructure Generation analysis, files required for Use Pass and On Demand 
Expansion can be exported as a .cpa substructure file. 

Bottom-up CMS: Export files for On Demand Expansion
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• The substructure file (*.cpa) can be 
imported using the Imported Condensed 
part object.

• The On Demand Expansion Option must 
be set to Yes for expansion to work with 
Imported Condensed Part.

Bottom-up CMS: Import Substructure file
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Bottom-up CMS: Perform on demand expansion

• Results can be expanded on the Imported Condensed part by selecting the scoping to 
Imported Condensed part
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Bottom-up CMS: Load vector limit for Substructure Generation

• Number of Load Vectors property is available for 
Substructure Generation analysis in Analysis Settings object

• When set to 0, which is the Program Controlled value and is the 
default, the application automatically detects the number of 
load vectors. The user can also specify the value using this 
property

• This setting enables efficient storage of load vector data and 
improves memory and performance of the application if this 
data is needed for many use pass steps.

• Based on the user specified input, /config,numsublv command 
is written to the input file
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Scope of Harmonic Balance Method Initiative - beta

Key 
Points

Model is mostly linear with some localized 
non-linearity such as friction dampers. 
Only periodic solutions are of interest.

Transient analysis is the currently only 
solution, but it is costly: large number of 
runs, long runs to reach steady-state.

HBM provides an efficient way to 
determine the multi-harmonic solution.

Non-
Linear 

Systems 
Dynamics

HBM

Non-Linear 
Harmonic 
Response

NNM

Non-Linear 
Normal 
Modes

STABILITY

Monodromy
matrix or Hill 

method 
(Floquet)

Recent Methods

BIFURCATIONS 
DETECTION
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Harmonic Balance Method Workflow

Pre-processing
- Linear elements and 

materials: no specifics -
CMS superelements
are also supported

- Non-linear elements:
- COMBIN39
- COMBIN40
- USERELEM
- CONTA178

Post-processing
Displacement solution at 
given frequency

Frequency Response 
FunctionMechanical 

DPF

rst HI 0

rst HI 1

rst HI 2

rst HI N

.

.

.

Solver
New option for 

harmonic analysis 
HROPT, HBM

HARMONIC

TRANSIENT

AFT

Results Files

MAPDL 
script

Each harmonic result file has the same format as for a regular 
harmonic analysis. No specifics for the post-processing of 1 harmonic.   
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2023R1 Example: Simplified model of blade-disk assembly with 
under platform damper [Poudou thesis 2007]

• Reduced order model of a beam:
‐ 2 master nodes: tip of the beam and friction point
‐ 2 normal modes

• Only transverse displacement allowed - UZ=0 

• Friction is 2D - constant normal force

• Reduced matrices are provided

free

stuck
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• Case 1: FX=20N, FY=15N
‐ Exhibits true 2D friction behavior
‐ Almost no stick-slip behavior (pure stick or pure slip only)
‐ Low number of harmonics needed (NH=3)

• Case 2: FX=20N, FY=2N
‐ Could be modeled with 1D friction
‐ Comparison to 1D friction shows good matching
‐ Stick-slip behavior on almost the whole frequency range
‐ High number of harmonics needed (NH=15)

2023R1 Example: Simplified model of blade-disk assembly with 
under platform damper [Poudou thesis 2007]

Case 2

Case 1

Trajectory of the friction 
point at F = 32.9 Hz

UX @ tip of the beam
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2023R1 Bolted Beam Assembly – HBM Customer Benchmark
- Prestressed CMS superelement
- Large number of node-to-node 

contact elements at interface
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Miscellaneous: Solver

• Mode Superposition Analyses: MCF file generation setting
‐ Generate MCF file by default for MSUP harmonic and MSUP transient analyses,

‐ Clean up local files for distributed ANSYS.
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Miscellaneous: Multi-Steps Harmonic

• Octave Band option for Harmonic 
Response and Harmonic Acoustics

• Step based Command Snippet for multi-
steps (Harmonic Response, Harmonic 
Acoustics and Coupled Field Harmonic)

• Remove beta flag for multi-steps 
Coupled Field Harmonic

• Remove beta flag for enforced motion 
and force applied on vertex
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Miscellaneous: On Demand Expansion

• Program Controlled Option On Demand Expansion:

Allow to activate On Demand Expansion automatically for supported scenarios
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Miscellaneous: Integration

• Maxwell to Harmonic Coupled Field Coupling (Beta):

Surface Force Density, Body Force Density and Remote Loads can be transferred from 
Maxwell to Harmonic Coupled Field



187

Miscellaneous

• Cyclic: Improve results when loading is applied on Cyclic Axis

• Response Spectrum: Option to send Command Snippet before 
the PFact command 

• Option on symmetry group to send High/Low components name 
in CYCLIC command (beta)

• Additional ERP formulation options (beta)

• Enforced Motion with Reduced Damped solver (beta)
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Miscellaneous

• Supported when the Solver Type property is set to either Direct, Unsymmetric, or Subspace
• Max Modes to Find property will accept the value of 0 to find all modes within the range. This entry 

to find all modes is valid only when Limit Search to range is set to Yes
• The modopt command will send "all" option to compute all modes as shown below for one case
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Miscellaneous

• Modal Effective Mass based Mode Selection Method is 
supported for Linked MSUP Harmonic and Transient analysis

• When the Mode Selection Method is set to Modal Effective 
Mass, the Significance Threshold can be specified (default is 
0.001). This will enable Harmonic analysis to select modes 
where the modal effective mass to total mass exceeds this level



Distributed Compute 
Services (DCS)
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Distributed Compute Services (DCS) enhancements

• Automatic download of results through an option

• Reconnect option to a recently disconnected DCS job

• Progress bar to indicate the live percentage of input files being uploaded when 
submitting the job.
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Distributed Compute Services (DCS) enhancements

• Introduce new solving state to signal the download of 
results which may not be relevant anymore​

• Clear generated data option to delete the generated 
files and better management of job

• Enable CMS use pass on DCS



Hydrodynamics
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Time Domain Wave Surface Animation

• Animation results in time domain 
Hydrodynamic Response systems now 
display the incident wave surface
‐ Regular or irregular waves
‐ Long- or short-crested wave spectra, 

including cross swell
‐ Imported wave height time histories
‐ Deep-water or finite-depth formulations
‐ Adjustable color palette and resolution

Stokes Regular Wave
Short-Crested Irregular Wave with Cross Swell
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Part Transforms in Aqwa Workbench

• Apply a Part Transform to modify the Part position or 
orientation directly in Aqwa Workbench

‐ No need to modify and re-import from the geometry editor
‐ Part features (Point Mass, Connection Points etc) also transformed
‐ Perform parametric studies of e.g. vessel draft/trim more easily

• Define an Internal Tank by Fluid Volume so that Internal Tank 
geometry can be transformed consistently

Initial position

Transform definition Transform preview Applied Part Transform



Workbench Additive
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Improved Automatic Distortion Compensation

• Compensation enabled in conjunction with spring-back and cut-off 
simulations

More user controls w.r.t to output geometry

Fig.2 Preview of faceted geometry that will be used for compensation

Fig.1 New re-faceting settingsPreview of faceted geometry

• Improvements in re-faceting the input stl mesh needed for 
compensation

• User controls for re-faceting operation
• Option to output stl at any/all iteration points
• "Zero Deformation at Base and Z Gap" are new options added to help 

with convergence. When enabled, the scaling of the deformations at 
nodes below the Z Gap will vary linearly from 0 at the baseplate to the 
1 at the Z Gap

• This new version allows the user to preview the faceted geometry that 
will be used for distortion compensation

Preview of the compensation convergence

Improved Usability

Fig.3 Preview of the compensation convergence

• The convergence plot visualizes the iteration data like average and 

maximum deviations against the respective criteria and the iteration 

number. This will give the user a real time visualization of the 

performance of distortion compensation with selected parameters
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Other Improved Capabilities into Mechanical Additive

• Read build files from various manufactures for scan pattern and 
ML thermal strain simulations in WB Mechanical

• Spring-back/Cut-off simulations are improved with directional 
removal

• Post-processing results include high strain 

• Majorly improved Additive Wizard now features
‐ Scan pattern, thermal strain along with earlier assumed strain

‐ Option to choose build file for a given machine manufacturer

‐ Add high strain result option

‐ Option to enable Directional Cutoff step

• Adaptive mesh coarsening using Octree
‐ For inherent strain simulations, mesh is coarsened adaptively away from laser 

source to reduce element count which in-turn helps reduce solver time.

‐ Element count reduced majorly in bulk areas of the geometries.

Other new capabilities

Fig.1 build file reader

Fig.2 Improved AM setup wizard

Video.1 Adaptive mesh coarsening using Octree
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Automatic Distortion Calibration Wizard

Customer pain points

• LPBF distortion simulation calibration workflow

• Users manually run distortion simulations by applying iteratively 
calculated Strain Scaling Factors (SSF) and Anisotropic Strain 
Coefficients (ASC) to match simulation results with experimental 
target values within a given tolerance. Such manual processes are 
repeated by utilizing spreadsheet calculation table

Value prop

• Streamline and automate the manual distortion calibration workflow 
for all LPBF distortion simulation modes via the new automatic 
distortion calibration wizard

• More calibration part types are added to calibration geometry library

Theme category

• Ease of use/Usability

SSF only calibration mode SSF + ASC calibration mode

DX module automatically optimizes calibration factor(s)
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Improved DED Simulation

Introduce Clustering Settings object

Improved Gcode reader performance

Simulation w/ non-planar base plate

Improved distortion prediction algorithm

Fig.1 Clustering Settings table

• A table which allows import, export, and modifications of machine 
parameters for each cluster during a DED simulation. Great for optimizing 
process settings and improving printing quality (e.g., reduce distortion and 
localized overheating, etc.)

Fig.2 Gcode clustering cost before and after improvements

• Gcode cluster generation has been optimized to give up to 40x by 
optimizing the clustering algorithm

• Enable DED simulation to consider parts building on non-planar base plates 
with improved contact generation workflow in wizard. It also provides a way 
to simulate DED repairing applications

• The simulation takes into account of geometry true shape after large 
deformation to offer a better match to the reality  

True shape

Before improvements

After improvements

Fig.4 Distortion prediction algorithm improvements

Fig.3 DED simulation w/ non-planar base plate

Part

Base



Explicit Simulation
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Explicit Dynamics
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Explicit Dynamics – Per Material Erosion Controls

• Four new erosion criteria have been added to Engineering Data to be added to 
materials for Explicit Dynamics analyses

• Allows each body in Mechanical to have a different erosion criteria

• Finer degree of control over behaviour of bodies in Mechanical

• Material based erosion controls work in combination with global erosion controls



LS-DYNA
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LS-DYNA Prep
Enhancements
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Drop Case Setup

• Drop Test Plugin LS-DYNA Analysis

+
• Use of the Center of Mass (CG) when 

determining  drop direction
• Offset of the Rigid Wall along the drop direction
• Multiple cases in a single Analysis
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Drop Case Setup

LS-DYNA Analysis

+
• Use of the Center of Mass (CG) when 

determining  drop direction
• Offset of the Rigid Wall along the drop direction
• Multiple cases in a single Analysis
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Coordinate System Definition

• New option to insert a coordinate system 
with the origin positioned at the center of 
mass

Mass = M Mass = 2*M Mass = M Mass = 2*M

Coordinate System (Origin @ 
Center of Geometry)

Coordinate System (Origin @ 
Center of Mass)

• Default center of mass calculation uses all 
unsuppressed bodies and point masses
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Coordinate System Definition

• Summary of existing coordinate system functionality

• Defining the principal axis direction using a 2 or 3 point selection

P1

P2

P1

P2
P3

Principal Axis Alignment 
Using 2 Points 

Principal Axis Alignment 
Using 3 Points 
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Coordinate System Definition

• Step 1 – Insert coordinate system with origin at 
the center of mass

• Step 2 – Select 1 or 2 points that will be used 
with the center of mass to define the drop 
direction

• Center of mass calculation and coordinate 
system creation can also be scripted allowing 
additional customization

Origin @ Center 
of Mass

Impact Point

Drop 
Direction
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Drop Plane Definition

• Rigid Wall
‐ Infinite plane (x, y, z = 0) of the selected coordinate 

system, with the normal to the plane given by the 
positive z-axis.

• Offset Type (None, Mesh, Gap, Mesh + Gap)
‐ Specifies an offset of the Rigid Wall plane along 

the z-axis
‐ The Mesh options offsets the plane to the furthest 

node in the negative z- direction

Mesh Offset

Gap
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Multiple Case Definition

• “Number of Cases” > 0  passes the CASE command 
line argument to the solver

• The solver splits the single input file into separate 
cases and solves each case producing a individual 
set of output files for each case

• Supported Objects:
‐ Initial Conditions
‐ Rigid Wall

• Keywords are wrapped in *CASE_BEGIN_n \
*CASE_END_n
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Additional Output Settings

• Selective Output (D3Part)
‐ Named selection of bodies

‐ Output frequency (Equally Spaced Points, Time)

• Maximum Stress Over Time (D3Max)
• Output frequency (Time)



Dimensionally Reduced Rigid Body Behavior

• Dimensionally reduced behavior for rigid body meshing is now supported in the LS-
DYNA system.

• In that approach , only the surfaces used in contact and boundary conditions are 
meshed. 

• This is the approach supported by the MAPDL solver

• Now a same rigid body behavior can be shared between implicit simulations and 
explicit simulations in the same model

214



LS-DYNA D3Part, D3Max & 
Case Postprocessing
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D3Part
• Allow to capture more results for a subset of the geometry, using Named Selections

for scoping

• Prep work in Mechanical
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D3Part

• Postprocessing

162 sets totally 
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D3Max

• Only support Stress result

• Contain a single time and be active when Maximum Over Time is set to Yes

• Pre work in Mechanical
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D3Max

• Postprocessing

Maximum Over Time will
become read-only when
the d3max file is selected

Only 1 set
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Case

• Provides a way of running multiple LS-DYNA analyses (or cases) sequentially by 
submitting a single input file.

• Prep work in Mechanical GUI
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Case

• Postprocessing

162 sets totally 



LS-DYNA other solvers



• LS-DYNA now supports support Smoothed Particle Galerkin ( SPG)

• SPG is particularly useful to simulate destructive manufacturing 

such as riveting, screwing, drilling and machining.

• SPG is only available for solid elements

SPG : Smoothed Particle Galerkin

SECID ELFORM=47 AET

DX DY DZ ISPLINE KERNEL SMSTEP

IDAM FS STRETCH ITB MSFAC ISC BOXID PDAMP

*SECTION_SOLID_SPG



ISPG : Incompressible Smoothed Particle Galerkin 

• The LS-DYNA system now supports Incompressible Smoothed Particle Galerkin ( ISPG)

• ISPG is suitable for the simulation of incompressible free surface fluid flow. 

• For instance, the simulation of shape evolution of solder joints in electronic equipment 
during the reflow process.

• ISPG is only available for tetra elements

*SECTION_FPD

*MAT_IFPD

SECID ELFORM

DX DY DZ

MCVISC

MID RO MU GAMMA



• Defines  contact between ISPG bodies and other finite element 

bodies

ISPG To Surface Coupling

*DEFINE_FP_TO_SURFACE_COUPLING
ISPG Part

FEM Part

SLAVE MASTER STYPE MTYPE

SBC SCA SFPN

SCA : Static Contact Angle between the ISPG and FE part
SFPN : Stiffness coefficient along the normal direction of the contact 
interface
SBC : Type of Boundary Condition : Free- Slip or Non-Slip boundary



Multibody Dynamics



Mechanical Motion
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Edge Contact

• Flexible body edge contact is available when contact region scoping contains edges.
‐ If users have a structural model that contains Edge Contacts, dynamic analysis can be performed 

easily by converting the system to Motion.

Surface vs Surface

Edge vs Surface

< Possible combinations >

Contact/Base

Face Edge

Target
/ Action

Face O O

Edge X (O-STD) O



229

FTire Interfacing

• Motion now supports co-simulation with cosin scientific software by using the FTire
format tire property file.

• RGR and CRG files can also now be used as road data files.

< Visualization of FTire simulation >
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Joint Consistency

• Universal Joint, Constant Velocity Joint and Translational Joint, that were not using 
consistent degrees of freedom between Motion and Rigid Dynamics have been made 
consistent.



Simulation Scenario with BC

• Simulation Scenario is available to DEACTIVATE or ACTIVATE Boundary Condition 
while running simulation according to the user-defined criterion.

< Deactivate BC relative to sphere at 0.3 s >
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Mesh Automation

• In assembly model, users should generate mesh for imported bodies to make the 
model ready to solve. It is difficult for users to notice and cumbersome to mesh 
manually.

• Now mesh will be generated after importing the bodies. So, it is possible to use 
geometry importing capability in Motion without considering this limitation anymore.

• Example: After creating a geometry for Tire object.
‐ Previously in this case, the state of mesh was Not Solved. 

‐ From 2023 R1, it will change to Solved.

< Previous vs. 2023 R1 >
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Numerical Damping

• It is now possible to input Numerical Damping within the range of values between 
zero and less than 4.

• Example: Pendulum simulation with Numerical Damping of 3.99 and 0.

< Numerical Damping 3.99 vs. 0 >
-> It can be seen that the smaller the value, 

the more freely the movement is.
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Residual Tolerance

• An option to use Error Tolerance Factor for NR Residual is now available in Analysis 
Settings.

• It may be helpful to clear this option if the number of NR failures is greater than 
number of integration failures.

• Solver provides recommendations via log file message, for better options in 
subsequent solutions.
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Solving Speed for Motor EM Force (with modal bodies)

• By optimizing the way of managing Electromagnetic force data that is imported 
from Maxwell, the simulation performance has been improved up to three times 
over previous versions.

< Motor EM Force with modal stator and rotor >



Ansys nCode Design Life
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1.1 Frequency-Based Modal Superposition Vibration Fatigue Analysis

• The DesignLife add-on now supports modal superposition frequency-based vibration fatigue using modal results.

Vibration Fatigue Load​ Stress​ Strain​
Shell 

Seam Weld​
Solid Seam Weld​

PSD Loading, Including:​
- Static Offset Case​

- Single and Multiple Events​
🗸 🗸 🗸 🗸

Single Frequency Loading, Including:​
- Static Offset Case​

- Single and Multiple Events​
🗸 🗸 🗸 🗸

Frequency Range Loading, Including:​
- Static Offset Case​

- Single and Multiple Events​
🗸 🗸 🗸 🗸

Sine On Random Loading, Including:​
- Static Offset Case​

- Single and Multiple Events​
🗸 🗸 🗸 🗸
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1.2 Frequency-Based Modal Superposition Vibration Fatigue Analysis

• This approach requires a 
modal results file and a Modal 
Coordinates file from a harmonic 
analysis.

• You can identify the mcf file 
location by linking the add-on 
to a Harmonic system or by 
importing it from an 
external location.
• Modal rst + mcf file from 

linked Harmonic system
• Modal rst + imported 

mcf file



239

2.1 Time-Based Modal Superposition Fatigue Analysis

• The DesignLife add-on now supports 
modal superposition time-based 
fatigue using modal results and 
time series loading.

• This approach requires a modal 
results file and a Modal Coordinates 
file from a transient system. You can 
identify the mcf file location by 
linking the add-on 
to a Transient system or by 
importing it from an external 
location.

• Modal rst + mcf file from linked 
Transient system

• Modal rst + imported mcf file
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2.2 Time-Based Modal Superposition Fatigue Analysis (Motion)

• The add-on also now supports modal 
superposition time 
series fatigue using Ansys Motion results.

• For Motion, you must link the add-on to 
the Modal environment 
containing the genCMS.rst file and import 
the appropriate Motion mcf file.

• Modal genCMS rst + imported 
Motion mcf file
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3.1 Seam Weld Material Customization

• DesignLife Add-on now supports 
customization of the weld material 
for Solid or Shell Seam Weld analysis. 

• You must identify the database 
(*.mxd file) containing the customized 
weld material data.

• Then select that material from the 
database.
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